
Analytical Reports - using Cognos Query Studio

Query Studio allows you to create your own custom reports. Unlike the Data 
Delivery System (DDS) that Query Studio will eventually replace, your report 
will contain data current to the time you run report. You can modify the look 
of your report by creating a Crosstab report or chart, filter for and/or 
manipulate report values, and perform calculations on quantitative report 
values. Topics include:

• Getting started
• Creating, running, and saving a report in Query Studio
• Manipulating report values 
• Changing the look and feel of your Query Studio report
• Working with Crosstab reports and charts.

Not everyone has access to Query Studio. For more information, go to the 
ROSS web page at http://ross.nwcg.gov

To start Query Studio from ROSS

To access Query Studio from the NWCG website see the next task, “To 
access Query Studio from the NWCG website.”

1 On the Administration menu, click Reports.

2 From the Cognos Connection screen on the Public Folders tab, click to 
select the Launch Query Studio link.

The following diagram shows the Public Folders in Cognos. The arrow points 
to the Launch Query Studio link.

To access Query Studio from the NWCG website

1 Start your Internet browser.

2 In the Address bar, type http://rossreports.nwcg.gov/cognos/c8/cgi-bin/
cognos.cgi and then press [ENTER].

3 On the Log on screen, click the Namespace drop-down arrow, click to 
select ROSSLDAPSSL, and then click OK.
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4 On the Log on screen, perform the following and then click OK

- Under User ID, type your ROSS user ID

- User Password, type your ROSS password.

5 On the Cognos Connection screen on the Public Folders tab, click the 
ROSS link, and then click to select the Launch Query Studio link.

The following diagram shows the initial Log on screen.

The following diagram shows the User ID and Password text boxes on the 
Log on screen.

The following diagram shows the Public Folders tab on the Cognos 
Connection screen. The arrow points to the ROSS link.

To log off Query Studio

To prevent unauthorized persons working in your Cognos profile you must 
close your Cognos Internet Explorer session. This is basic security protocol 
similar to logging out of ROSS, to prevent unauthorized use of your ROSS 
profile.

• On the Cognos Connection toolbar, click the Log Off link, and then click 
OK.
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The following diagram shows the Cognos Connection toolbar. The arrow 
points to the Log Off link.

Getting started
This section explains the terminology and functionality in Query Studio. This 
section also outlines the toolbars, menu, and submenus you will use while 
creating, running, and saving your reports. Topics include:

• Understanding Query Studio terminology and functionality
• Understanding Query Studio toolbars
• Understanding the Query Studio Menu and submenus.

Understanding Query Studio terminology

Some of the basic terminology when creating reports in Query Studio 
includes:

• Analytical Reporting System Data Dictionary. The Analytical 
Reporting System Data Dictionary contains the definitions of the data 
elements used in Cognos. Located on the ROSS web site under “DDS/
Analytical Rpts, it allows you to obtain information on how subject areas 
can relate to each other.

• Cascading Filter. A cascading filter is a pre-defined filter that filters for 
multiple report items. The filters are listed in sequence, where the first 
report item is the first filter performed, and the last report item is the last 
filter performed. Selections made at each level of the filter also filters the 
selections available at lower levels of the filter. Cascading filters are listed 
under the corresponding subject area on the Insert menu.

For example, if you select a filter for the Overhead catalog, only 
categories appropriate to the Overhead catalog display as selections for 
the next level of filter. For more information about using cascading filters 
see, “To add a cascading filter to your report,” in the section, “Working 
with filters,” later in this chapter.

• Drop Zone. The drop zone is where you place selected query items when 
building your report. You can move query items into the drop zone by 
performing one of the following

- double-click the query items in the order you want to viewed them in 
your report
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- drag and drop query items in the order you want to viewed them in 
your report

- press and hold CTRL, click to select the query item(s) in the order you 
want to view them in your report, and then click the Insert button.

For more information about cutting and pasting columns see, “Changing 
the look and feel of your Query Studio report,” later in this chapter.

• Independent Subject Areas. This folder contains subject areas that were 
built to “stand alone.” Their query items may not be combined with query 
items from other subject areas.

• Integrated Subject Areas. This folder contains Incidents, Request, and 
Resources query subjects. These subject areas are classified as 
“integrated” because relationships exist between the underlying data 
structures in these subject areas. This allows you to select and combine 
query items from different subject areas into a single report.

For example, you can create a report using query items from the Incident 
subject area and the Incident query subject, and query items from the 
Request subject area and Request query subject.

• Query Item. A query item is an individual field in the query subject 
(source). It is the lowest level of information. Once you add a query item 
to the drop zone it becomes a “report item.”

• Report Item. A report item is a query item you added to your report by 
adding it to the drop zone. In a List Report, report items are listed in 
columns, with the report item names listed as the column headings. By 
default, when adding a report item to your report, the report item is added 
as the next column.

• Report Value. A report value is the information returned from the 
database to an individual cell in a column or row. 

Understanding Query Studio toolbars

The buttons on the Query Studio Standard toolbar allow you to manipulate the 
data and change the appearance of your reports. 

Query Studio Standard toolbar.

The buttons on the Query Studio Style toolbar allow you to change the font 
style and color, the background color, and border style of your report. 
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Query Studio Style toolbar

Understanding the Query Studio Menu and submenus

When creating a report in Query Studio, the Query Studio Menu displays 
along the left-hand side of your screen. There are five submenus on the Query 
Studio Menu, including:

• Working with the Insert Data submenu
• Working with the Edit Data submenu
• Working with the Change Layout submenu
• Working with the Run Report submenu
• Working with the Manage File submenu.

Working with the Insert Data submenu

The Insert Data submenu automatically displays whenever you create a report 
using Query Studio.This submenu allows you to locate and move query items 
into the “drop zone.”

To locate query items on the Insert Data submenu

1 Under Menu, click Insert Data.

2 Click the expand button for the subject area of your choice, and then 
click the expand button for the query subject of your choice.

3 Click the expand button for the dimension of your choice.

4 Scroll to locate the query items of your choice.

For more information about using Query Studio see, “Creating reports from 
Query Studio,” later in this chapter.
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The following diagram shows the Insert Data submenu, options, and 
terminology.

Working with the Edit Data submenu

The Edit Data submenu displays when using Query Studio to edit and/or 
manipulate data in your Query Studio reports. You can perform one or more 
of the following functions:

• filter text, numbers, and date and time data
• filter for missing values for quantitative data
• sort data
• calculate quantitative data
• summarize report values.

For more information about using Query Studio see, “Creating reports from 
Query Studio,” later in this chapter.
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The following diagram shows the Edit Data submenu, options, and 
terminology.

Working with the Change Layout submenu

The Change Layout submenu allows you to customize the format of your 
Query Studio reports. You can perform one or more of the following 
functions:

• create sections and subsections within the report
• create groups and subgroups of report values
• add or change border styles
• change font styles, set page breaks and create a Crosstab report.
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The following diagram shows the Change Layout submenu, options, and 
terminology.

Working with the Run Report submenu

The Run Report submenu allows you to preview your report using just some 
of the data. The Run Report submenu also allows you to specify the file 
format of your report. You can save your report in the following formats:

• Adobe PDF, to save the report as it appears on your screen - default
• Microsoft Excel, to save the report as a spreadsheet
• CSV, to save the report using commas that separate the tabular data
• XML, to save the report for sharing on the Internet.

For more information see, “Running reports in other formats,” later in this 
chapter.
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The following diagram shows the Run Report submenu, options, and 
terminology.

Working with the Manage File submenu

The Manage File submenu allows you to create and save new Query Studio 
reports. It also allows you to view the report definition (origination) of each 
report item in your report. 

For example, the report item “Inc Disp” has a report definition of 
[Incidents].[Incidents].[Inc Disp Org Unit Code]. This means that Inc Disp 
originates from the Incidents subject area, the Incidents query subject, and 
the Inc Disp Org Unit Code query item.
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The following diagram shows the Manage File submenu, options, and 
terminology.

Creating, running, and saving a report in Query Studio
When you place query items into the drop zone, Query Studio instantly 
returns reports values. Once moved into the drop zone, query items are called 
“report items.” There are three ways you can add query items into the drop 
zone:

• Double-click each query item, in the order you want listed in the report.

The solid, blinking black line that displays in the drop zone indicates 
where the query item will be placed. By default, each new query item is 
added as the next column.

• Drag and drop each query item into the drop zone, positioning each query 
item where you want it listed in the report.

• Click to select one or more query items in the order you want them to be 
listed, and then click the Insert button.

To create and run a report in Query Studio

1 On the Query Studio toolbar under the Insert Data submenu, click to 
select the folder of your choice.

2 Click the expand button for the subject area of your choice.

3 Click the expand button for the query subject of your choice.
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4 Click or drag and drop the query items of your choice into the drop zone.

You can also click to select the query item(s) of your choice, and then 
click the Insert button.

5 To name the report, click Title, and then complete the Title and Subtitle 
boxes on the Edit Title screen.

6 On the Edit Title screen, click the Show filters and Show sorts check 
boxes as appropriate, and then click OK.

The following diagram shows the Insert Data submenu. The arrow points to 
the Integrated Subject Area subject area folder.

The following diagram shows the progress of a report being developed in 
Query Studio. The arrow points to the position where “Incident Date” is about 
to be placed. 
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The following diagram shows the Edit Title screen.

The following diagram shows a simple Query Studio report.

To save a Query Studio report

1 On the Query Studio Standard toolbar, click the Save or Save As 
button.

2 On the Save As screen, complete the following text boxes and then click 
OK

- Name
- Description
- Screen Tip.

Be sure to save your report to My Folders.
12 version 2.9 July 1, 2009



Analytical Reports - using Cognos Query Studio ROSS User’s Guide
The following diagram shows the Save As screen. The arrow points to My 
Folders, where the report will be saved.

Manipulating report values 
The Edit Data submenu allows you to manipulate both qualitative and 
quantitative data. Topics include:

• Working with filters
• Performing searches
• Sorting, grouping, summarizing, and calculating.

Working with filters

This section explains how to use filters in Query Studio. You can use 
cascading filters and/or develop your own to create a report that displays only 
the data you need.

The following diagram shows a portion of the Insert menu. The arrows point 
to two cascading filters available for the Incidents subject area. 
July 1, 2009 version 2.9 13



ROSS User’s Guide Analytical Reports - using Cognos Query Studio
To add a cascading filter for your report

Cascading filters do not automatically refresh the data. To keep the data in 
your report current, save the report in My Folders and run the report again, or 
click Run with All Data from the Run Report submenu.

1 On the Cognos Query report of your choice, click the Insert menu.

2 Drag-and-drop the cascading filter of your choice into the drop zone.

3 On the Prompt screen that displays for your report, click to select the 
first set of values in the Provide a value list box, and then click the 
Reprompt button.

To select more than one value at a time, click and hold [CTRL], and then 
click to select the values of your choice.

4 Click to select the next set of values, clicking the Reprompt button after 
each selection, and then click OK when finished.

The following diagram shows a sample report. The arrow points to a 
cascading filter being inserted into the drop zone.
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The following diagram shows a sample Prompt screen.

The following diagram shows the resulting report after the cascading filter is 
applied.
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To display filter subtitles

1 On the Query Studio report of your choice, click the Title of the report.

2 On the Edit title area screen, click to select the Show filters check box.

The following diagram shows the Edit title area screen. The arrow points to 
the Show filters check box.

To filter for missing report values

1 Create the Query Studio report of your choice.

2 Under Menu, click the Edit Data submenu.

3 Click to select the column heading of your choice, and then click the 
Filter link.

4 On the Filter screen, click the Missing Values link, and then click the 
Missing Values drop-down arrow.

5 Click to select the option of your choice.

6 Click to select the Apply the filter to individual values in the data 
source check box, as appropriate, and then click OK.

The following diagram shows the Filter screen. The arrow points to the 
Missing Values link.
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To filter for missing report values - an example

This example explains how to filter for missing Contract Start Dates and 
Contract End Dates. You can create a report that shows only these missing or 
“null” report values.

1 Create the Query Studio report of your choice.

This example lists Contract Number, Contract Type, Contract Start Date, 
Contract End Date, and Contract Org Name.

2 Under Menu, click the Edit Data submenu.

3 Click to select Contract Start Date, and then click the Filter link.

4 On the Filter screen, click the Missing Values link, and then click the 
Missing Values drop-down arrow.

5 Click to select Show only missing values click to select the Apply the 
filter to individual values in the data source check box, as appropriate, 
and then click OK.

Repeat the filter for Contract End Date to be certain you filtered for all 
missing values.

The following diagram shows a sample report. The arrow points to the 
Contract Start Date, which will be filtered for missing values.
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The following diagram shows the Filter screen. The arrow points to the Show 
only missing values option.

The following diagram shows the sample report after applying the filter to the 
Contract Start Date.

Performing searches

This section explains how to perform a search for report values using the 
Filters button and the Filters (Search for Values) screen. The Filters (Search 
for Values) screen allows you to define search criteria for report values, 
including the following:

• Keywords text box. Type one or more keywords for your search of report 
values. Separate each keyword by a space.
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• Search button. Click the Search button to perform a search using the 
Keywords, Options, and Case insensitive check box criteria. Search 
results display in the Results text box.

• Options link. Click the Options link to narrow the keyword search using 
one of the following keyword criteria

- Starts with any of these keywords
- Starts with the first keyword and contains all of the remaining 

keywords
- Contains any of these keywords
- Contains all of these keywords.

• Case insensitive check box. Click to select the Case insensitive check 
box to specify that upper and lower-cased text is not used as part of the 
keyword search criteria.

• Results text box. This text box displays search results from the 
Keywords, Options, and Case insensitive check box criteria. Click to 
select one or more of the report values in the Results text box, and then 
click the Insert button to add these report values to the Conditions text 
box.

• Missing values link. Click the Missing values link to search using one of 
the following missing values criteria

- Include missing values
- Leave out missing values
- Show only missing values.

• Apply the filter to individual values in the data source check box. 
Click the Apply the filter to individual values in the data source check box 
to specify that individual report values will be filtered using the missing 
value criteria.

• Insert button. Select the report value(s) from the Results text box, and 
then click the Insert button to move report values to the Condition text 
box.

• Remove button. Select the report value(s) from the Condition text box, 
and then click the Remove button to move report values back to the 
Results text box.

• Condition drop-down arrow. Click the Conditions drop-down arrow to 
specify one of the following options

- Show only the following
- Do not show the following (NOT).

• Conditions text box. The Conditions text box lists resulting report values 
to be either included or excluded from your report.
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To search for report values you specify

1 Create the Query Studio report of your choice.

2 Click to select the column heading of your choice, and then click the 
Filter button.

If viewing your report from the Edit submenu, you can click the Filter link.

3 On the Filters (Pick values from a list) screen, click the Search for 
Values link.

4 On the Filter (Search for Values) screen, complete the following as 
appropriate for the search, and then click the search button

- Keywords
- Options
- Case insensitive
- Missing values
- Apply the filter to individual values in the data source.

5 Under Results, click to select the report value(s) of your choice, and 
then click the Insert button.

6 When finished, click OK.

The following diagram shows a sample report before performing the search 
for Inc Type Code.
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The following diagram shows a sample Filter (Search for Values) screen.

The following diagram shows the resulting report after the search.
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To filter report values by picking from a list

1 Create the Query Studio report of your choice.

2 Under Menu, click the Edit Data submenu.

3 Click to select the column heading of your choice, and then click the 
Filter link.

4 On the Filter (Search for Values) screen, click the Pick values from a 
list link.

5 On the Filter (Pick values from a list) screen, click the Condition 
drop-down arrow, and then click to select the condition of your choice.

6 Click to select the report values of your choice, and then click OK.

The following diagram shows the Filter (Search for Values) link on the Filter 
(Search for Values) screen. The arrow points to the Pick values from a list 
link.
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The following diagram shows a sample Filter (Pick values from a list) screen.

To filter report values by typing your own list

Report values are case-sensitive and must be an exact match. You cannot 
use wildcards.

1 Create the Query Studio report of your choice.

2 Under Menu, click the Edit Data submenu.

3 Click to select the column heading of your choice, and then click the 
Filter link.

4 On the Filter (Search for Values) screen, click the Type in values link.

5 Click the Condition drop-down arrow, and then click to select one of the 
following conditions

- Show only the following
- Do not show the following (NOT).

6 On the Filter (Type in values) screen under New value, type the report 
value of your choice to match the condition, and then click the Insert 
button.

7 Click to select the report values of your choice, and then click OK.
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The following diagram shows a sample report with Inc Name selected. The 
arrow points to the Filter link.

The following diagram shows the Filter (Search for Values) link on the Filter 
(Search for Values) screen. The arrow points to the Type in values link.
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The following diagram shows the Filter (Type in values) screen. In this 
example Inc Names, “BENSON” and “NORTHWOODS,” will be filtered out 
from your report.

The following diagram shows the resulting report after the filter is applied.

Sorting, grouping, summarizing, and calculating

This section explains how to sort and group report values, summarize report 
values, and perform calculations on report values in your report. 

To display sort subtitles

1 On the Query Studio report of your choice, click the Title of the report.

2 On the Edit title area screen, click to select the Show sorts check box.
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The following diagram shows the Edit title area screen. The arrow points to 
the Show sorts check box. 

To sort report values

• On the Query Studio report of your choice, to select the column 
heading of your choice, and then click the Sort button.

The following diagram shows a sample report. The arrow points to the Sort 
button.
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To change the default sort order of the column

1 On the Query Studio report of your choice, click the sort subtitle of 
your choice.

To display sort subtitles, click the Title, and then click to select the Show 
sorts check box on the Edit title area screen.

2 On the Sort screen, click to select the Sort order option of your choice, 
and then click OK.

The following diagram shows the Sort screen.

To group report values

Grouping report values allows you to hide duplicate values. You cannot group 
measures (quantitative data).

• On the Query Studio report of your choice, to select the column 
heading of your choice, and then click the Group button.
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The following diagram shows a sample report before grouping the Inc GACC 
Org Name column.

The following diagram shows a sample report after grouping the Inc GACC 
Org Name column.
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To group a span of report values - an example

This example explains how to filter for Contract Start Dates beginning in June, 
2008 and ending in September, 2008. Next, you will group this “span” (known 
as “range” in Cognos) of report values to hide the duplicates.

1 Create the Query Studio report of your choice.

This example lists Contract Number, Contract Type, Contract Start Date, 
Contract End Date, and Contract Org Name.

2 Under Menu, click the Edit Data submenu.

3 Click to select Contract Start Date, and then click the Filter button.

4 On the Filter screen, complete the following information and then click 
OK

- click the Conditions drop-down arrow and then click to select Show 
only the following

- in the From Date text box, click the calendar, and then click to select 
June 1, 2008

- in the To Date text box, click the calendar, and then click to select 
September 30, 2008.

5 Click the Group button.

Since you applied the filter from the previous step to the Contract Start 
Date, this column heading should already be selected.
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The following diagram shows a sample report and the Filter screen. The 
arrows point to the filter used for this example.
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The following diagram shows the sample report after applying the filter to 
Contract Start Date.
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The following diagram shows the sample report after grouping the filtered 
Contract Start Date.

To calculate quantitative report values

The results of the calculation creates a new column in your report. Cognos 
performs a re-calculation each time the report is run.

1 On the Query Studio report of your choice, to select the column 
heading of your choice, and then click the Calculate button.

You may select multiple report items for your calculation, such as First 
Name and Last Name. For more information see the next task, “To 
perform a calculation on multiple report values.”

2 On the Calculate screen, click the Operation drop-down arrow, and then 
click to select the operation of your choice.

3 Based on the column heading you selected, complete the Calculate 
screen as appropriate.

The operations available depend on the type of data (alphanumeric, 
numeric, date) in the column heading(s) you select.

4 In the New item name box, type the name of the new column heading, 
as appropriate, and then click the Insert button.

You can, if desired, delete the report item used for the calculation as it is no 
longer needed.
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The following diagram shows a sample report before performing a calculation 
on the Initial Date column.

The following diagram shows a sample Calculate screen for creating a new 
column, “Year.” In this example, Initial Date is used to create a new column 
that lists only the Year.
July 1, 2009 version 2.9 33



ROSS User’s Guide Analytical Reports - using Cognos Query Studio
The following diagram shows a sample report after performing a calculation 
on the Initial Date column.

To concatenate multiple report values - an example

The sample screens in this task shows how to create a new column that lists 
Last Name, First Name.

1 On the Query Studio report of your choice, click to select the column 
headings of your choice, and then click the Calculate button.

2 On the Calculate screen, click the Operation drop-down arrow, and then 
click to select Concatenation.

3 Under New item name, type the name of the new column heading.

4 Under Separator between report items, click to select the separator of 
your choice, or type the separator of your choice in the text box.

In this example, a comma followed by a space is used to separate Last 
Name from First Name.

5 Complete the following text boxes as appropriate, and then click the 
Insert button.

- Preceding text
- Following text.

6 To delete the source report values used in the concatenation, click to 
select the column headings of your choice, and then click the Delete 
button.
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The following diagram shows a sample report of resource names. The column 
headings, “Last Name” and “First Name,” are selected for the calculation.

The following diagram shows the Calculate screen for concatenating Last 
Name and First name. 
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The following diagram shows the resulting calculation and new column 
heading, “Resource Name.” 

The following diagram shows the completed report. The Last Name and First 
Name report values have been deleted from the report.
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To summarize report values without footers

The type of summary you can perform depends on the type of data you 
select. It is a form of calculation that condenses (summarizes) your data. In 
this example, the Inc Name column is summarized to display counts instead 
of individual incident names.

1 On the Query Studio report of your choice, click the Edit Data 
submenu.

2 Click to select the column heading of your choice, and then click the 
Summarize link.

3 On the Summarize screen, click the Advanced link.

4 On the Summarize (advanced) screen, click the Summary for cells 
drop-down arrow, and then click to select one of the following

- Count Distinct
- Count
- None.

For this example, click to select Count.

5 Click the Summary for footers drop-down arrow, click to select one of 
the following, and then click OK

- Total
- Average
- Maximum
- Minimum
- Median
- Standard Deviation
- Variance
- Count Distinct
- Count
- Calculated
- Automatic
- None.

For this example, click to select None.

6 Rename the Title and column heading as appropriate.
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The following diagram shows a sample report before summarizing the Inc 
Name column. 

The following diagram shows the Summarize screen. The arrow points to the 
Advanced link.

The following diagram shows the Summary (advanced) screen. In this 
example, the Summary for cells is set to “Count,” which returns the total 
number of records, and the summary for footers is set to “None.”
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The following diagram shows a sample report after summarizing the Inc 
Name column. 

To summarize report values with footers

In this example, the Inc Name column displays counts. The footer displays the 
total number of incidents. 

1 On the Query Studio report of your choice, click the Edit Data 
submenu.

2 Click to select the column heading of your choice, and then click the 
Summarize link.

3 On the Summarize screen, click the Advanced link.

4 On the Summarize (advanced) screen, click the Summary for cells 
drop-down arrow, and then click to select one of the following

- Count Distinct
- Count
- None.

For this example, click to select Count.
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5 Click the Summary for footers drop-down arrow, click to select one of 
the following, and then click OK

- Total
- Average
- Maximum
- Minimum
- Median
- Standard Deviation
- Variance
- Count Distinct
- Count
- Calculated
- Automatic
- None.

For this example, click to select Total.

6 Rename the Title and column heading as appropriate.

The following diagram shows a sample Summarize (advanced) screen for 
displaying the total number of incidents.
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The following diagram shows the Summary row that displays on the last page 
(bottom) of the report. 

If your report is more than one page, click the Bottom link to view the 
Summary footer.

Changing the look and feel of your Query Studio report
The Change Layout submenu allows you to change the look and feel of your 
report. You can perform the following:

• cut and paste or delete columns of data
• change column headings, fonts, or borders
• change the title
• set page breaks and number of rows per page
• swap rows and columns
• create sections and subsections.

To cut and paste a column

1 On the Query Studio report of your choice, click the Edit Data 
submenu.

2 Click to select the column heading for the report item you want to cut, 
and then click the Cut link.
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3 Click to select the column heading where you want the paste the cut 
report item, and then click the Paste link.

The cut column will be pasted before the column you select.

The following diagram shows a sample report with the column heading, 
“Initial Date” selected. The arrow points to the Cut link on the Edit submenu.
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The following diagram shows the sample report after the Initial Date report 
item has been cut from the report.

The following diagram shows the sample report after the Initial Date report 
item was pasted before Inc GACC Org Name.
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To delete a column

If you choose to delete a column that has a filter applied to it, you must either 
delete the column but keep the filter, or delete both the column and the filter.

1 Click to select the column heading of your choice, and then click the 
Delete button on the Query Studio Standard toolbar.

2 To keep the filter, if one is applied to the selected column heading, click to 
clear the check box for that filter on the Delete screen.

To delete the filter, click OK on the Delete screen.

The following diagram shows a sample Delete screen for deleting a column 
with a filter applied to it. The arrow points to the check box to clear if you 
want to delete the column but do not want to delete the filter.

To change a report item heading

1 On the Query Studio report of your choice, double-click the column 
heading of your choice.

2 On the Rename screen, type the new name of the column heading in the 
Name box, and then click OK.

The following diagram shows the Rename screen.

To change the report text font, size, and formatting

1 On the Query Studio report of your choice, click to select the column 
heading, Title, or other heading of your choice.

2 To change the font, click the Font drop- down arrow on the Query Studio 
Standard toolbar, and then click to select the font of your choice.
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3 To change the size of the font, click the Size drop-down arrow on the 
Query Studio Standard toolbar, and then click to select the font of your 
choice.

4 To change the formatting, click the Bold, Italic, and/or Underline buttons 
on the Query Studio Standard toolbar.

The following diagram shows a partial list of fonts available in Query Studio.

To change the report title

• On the Query Studio report of your choice, click the report title, and 
then complete the Title box as appropriate.

The following diagrams shows the Edit title area screen.

To add or change borders in your report

1 On the Query Studio report of your choice, click the Change Layout 
submenu.

2 On the Change Layout submenu, click the Change Border Styles link.

3 On the Change border styles screen under Table borders, click to select 
one of the following borders

- All borders
- Headings
- Headings and Summaries
- No borders.

4 Under Color, click the drop-down arrow, and then click to select the 
border color of your choice.
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5 Click the Width drop-down arrow, and then click to select the border 
width of your choice.

6 When finished, click OK.

The following diagram shows a sample Change border styles screen.

To set page breaks in your report

To set page breaks in a list report, you must select one grouped or sectioned 
report item. 

1 On the Query Studio report of your choice, click the Change Layout 
submenu.

2 On the Change Layout submenu, click the Set Page Breaks link.

To set the number of rows per page

1 On the Query Studio report of your choice, click the Change Layout 
submenu.

2 On the Change Layout submenu, click the Set Web Page Size link.

3 On the Set web page size screen, click the Number of rows drop-down 
arrow, and then click to select the number of your choice.

The following diagram shows the Set web page size screen.
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To show row numbers in your report

1 On the Query Studio report of your choice, click the Change Layout 
submenu.

2 On the Change Layout submenu, click the Set Web Page Size link.

3 On the Set web page size screen, click the Show row numbers check 
box, and then click OK.

To create a section

The report value you select becomes the heading of a section.

1 On the Query Studio report of your choice, click the Change Layout 
submenu.

2 Click to select the first cell in the column of your choice, and then click 
the Create Sections link.

You may also click the Create Sections button on the Query Studio 
Standard toolbar.

The following diagram shows a sample list report. The arrow points to Inc 
Type, which will be used to create a section.
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The following diagram shows the sample list report after creating a section for 
Inc Type.

Working with Crosstab reports and charts
The Change Layout menu allows you to create a Crosstab report and/or a 
chart from the most summarized data of your report. Topics include:

• Creating a Crosstab report
• Creating a chart.

Creating a Crosstab report

Create a Crosstab report when your report displays the same rows for multiple 
report items, you want to swing the common rows up to become columns, 
and/or you want to show measures at the intersection of each row and column.

To create a Crosstab report of summarized values

1 Create and save the Query Studio report of your choice.

2 Summarize the report cell(s) of your choice.
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3 Click to select the column heading to use as the common row, and then 
click the Pivot button on the Query Studio Standard toolbar.

4 Rename the report as appropriate, and then click OK.

The following diagram shows a sample report before pressing the Pivot 
button. Inc Name has been summarized and Year is selected as the common 
row.
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The following diagram shows the resulting Crosstab report.

To sort a Crosstab report

1 Under Menu, click to select the Edit Data menu.

2 On the Crosstab report of your choice, click the first cell of the column 
you want to sort, and then click the Sort button.

To swap rows and columns

You can only swap rows and columns if your report contains a Crosstab or a 
chart based on a Crosstab. 

• On the Query Studio Crosstab report of your choice (or a chart based 
on a Crosstab report), click the Swap Rows and Columns button.
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The following diagram shows a portion of sample crosstab report before the 
swap.
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The following diagram shows the sample crosstab report after the swap,

Creating a chart

The Change Layout menu allows you to create a chart from the most 
summarized data of your report. The report must have at least one measure 
(quantitative data) and one non-measure (qualitative data), but must have no 
more than two non-measures. The report may have unlimited measures. When 
creating a report to generate a chart, remember these key points:

• You must have at least one measure (quantitative data) and one 
non-measure (qualitative data) to create a chart. 

• You can graph an unlimited number of measures, but a maximum of two 
non-measures. 

• Remove measures not meaningful to the chart.

• Reorder non-measurement columns as needed.

• Collapse any groups.

To create a chart from your Query Studio report

1 Create the Query Studio report of your choice, and then click the Edit 
Data submenu.
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2 Perform the appropriate calculations and/or summarizations, and then 
remove non-meaningful measures and non-measures from the report.

3 On the Query Studio Standard toolbar, click the Chart button.

4 On the Chart screen, click the Chart type drop-down arrow, click to 
select one of the following chart options

- Column
- Column - Line
- Bar
- Area
- Pie
- Line
- Radar.

5 Click to select the Show the values on the chart check box, as 
appropriate.

6 Under Show the following on the report, click to select one of the 
following, and then click OK

- Chart and table
- Chart only.

The following diagram shows a sample report of incident counts for the year 
2007.
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The following diagram shows the Chart screen. The arrow points to the Chart 
type drop-down arrow. 

To create a pie chart - an example

This example uses the sample Query Studio report, “Incidents from 2004-
2008 by GACC, Type, and Year,” to plot the Number of Incidents (quantitative 
data) by Incident Type (qualitative data).

1 Create and save the Query Studio report containing the following data

- Inc Type
- Inc Name
- Inc GACC Org Name
- Initial Date.

2 On the Menu, click to select the Edit Data submenu.

3 Calculate the Year, change the heading to Year, and then filter to list only 
the year 2007.

4 Summarize the Inc Name to count the number of incidents, and then 
change the column heading to Number of Incidents.

5 Delete the Inc GACC Org Name and Year columns.

6 On the Query Studio Standard toolbar, click the Chart button.

7 On the Chart type drop-down arrow, click to select Pie, click to select the 
pie chart of your choice, and then click OK.

8 Change the title to Number of Incidents in 2007 by Type.
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The following diagram shows the Chart screen for creating a pie chart.

The following diagram shows the resulting pie chart from the sample report.
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